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COPYRIGHT © 2011, 2016  Pennington Publishing 
  
NOTICE TO THE READER 
 
 All rights reserved Pennington Publishing 2011. Permission is hereby 
granted to the individual purchaser to reproduce student materials in this book for 
noncommercial individual or classroom use only. Purchase of The Pennington Manual 
of Style grants you, the purchaser, and your students full license to use these resources 
at school and at home.  
  
Material from this book has been previously published in the author’s Teaching Essay 
Strategies © 2001, 2011, Grammar, Usage, Spelling, and Mechanics © 2013, Teaching 
Grammar and Mechanics © 2003, 2011, and Teaching Reading Strategies © 2008. 
These curricula are available for purchase at www.penningtonpublishing.com. 
  
Other than the heretofore specified limited permission for reproduction, the text of this 
publication, or any part thereof, may not be reproduced or transmitted in any form or by 
any means, electronics or mechanical, including photocopying, recording, storage in an 
information retrieval system, or otherwise, without prior written permission of the 
publisher. 
  
The Publisher makes no representation or warranties of any kind, including but not 
limited to, the warranties of fitness for particular purpose or merchantability, nor are 
any such representations implied with respect to the material set forth herein, and the 
publisher takes no responsibility with respect to such material. The publisher shall not 
be liable for any special, consequential, or exemplary damages resulting, in whole or 
part, for the readers’ or students’ reliance upon, this material. 
 
Curricula Designed to Teach the Essay e-Comments Content 
 
The Essay e-Comments have been derived from the following comprehensive curricula: 
Teaching Essay Strategies, Grammar, Usage, Spelling, and Mechanics, 
Teaching Grammar and Mechanics, and Teaching Reading Strategies and 
are available at www.penningtonpublishing.com. Each curriculum uses the same 
language of instruction as does The Pennington Manual of Style. Each curriculum 
provides diagnostic assessments to determine the individual needs of students in 
writing, spelling, grammar, mechanics, and reading. Each curriculum provides targeted 
worksheets with formative assessments and activities to enable the teacher to 
differentiate instruction.  
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Introduction 
 
The Pennington Manual of Style has been designed to serve both students and teachers.  
  
The user-friendly The Pennington Manual of Style provides 438 writing tips. Each 
writing tip has a concise definition, explanation, and a clear example. Writing tips are 
organized into these categories: Essay Organization and Development (Introduction, 
Body, and Conclusion), Coherence, Word Choice, Sentence Variety, Writing Style, 
Format and Citations, Parts of Speech, Grammatical Forms, Usage, Sentence Structure, 
Types of Sentences, Mechanics, and Conventional Spelling Rules. As a quick reference 
guide, this style manual will help developing writers learn what is correct and why it is 
correct.  
  
For teachers, this guide will provide a common language of writing instruction and 
discourse for teachers and students. Teachers will find the concise writing tips useful for 
both direct instruction and essay comments. And most importantly, all 438 writing tips 
have been formatted as Essay e-Comments for the Autocorrect function of Microsoft 
Word®. After adding in the comment bank, the teacher simply types in the assigned 
alphanumeric code and the entire formatted writing comment appears where desired on 
the student’s Word document or on a printed comments page.  
 
Using Essay e-Comments Makes Sense  
  

• Manually responding to essays in red ink can be time-consuming and frustrating. 
Teachers find themselves using the same comments over and over again, while 
most students barely glance at their final grade or rubric score and maybe skim 
the comments before cramming their papers into the depths of their backpacks.  

• Using Essay e-Comments will save time. Most teachers can respond to and/or 
evaluate essays in half the time it takes to manually correct. 

• Using Essay e-Comments simply does a better job than manual correction. Each 
comment has a definition, explanation, and example to help students learn what 
is correct and why it is correct. And teachers can certainly add in their own 
comments. Unlike other e-grading programs, teachers can save their custom 
comments.  

• Having students submit their essays on the computer allows the teacher to insert 
comprehensive and prescriptive comments into their Microsoft Word® 
documents. Teachers can require their students to address each comment by 
using Microsoft Word® “Track Changes.” Students then re-submit revisions and 
edits for peer and/or teacher review. Just like real professional writers do with 
their editors!  

• Teachers can select and print out Essay e-Comments for paper submissions to 
provide response/editing feedback and/or to supplement an evaluative rubric. 

• Using the 438 e-comments enhances the interactive writing process. The teacher-
student interaction changes from static summative evaluation to dynamic 
formative assessment.  
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How to Insert Essay e-Comments into Microsoft Word® Docs 
 
1. Click on this link to download all 438 Essay e-Comments:  

http://blog.penningtonpublishing.com/wp-content/uploads/2015/12/Autocorrects.exe    
Save if prompted and click RUN despite the scary Microsoft warning that it doesn’t 
recognize the software. Don’t worry: This program is virus-free. The download has 
been tested for Microsoft Word® 2003, 2007, 2010, 2013, 2016 (Windows XP, 
Vista, and Win 7, 8, and 10. The program works fine with Google docs. Simply batch 
download into Word®, open the docs in Word® and insert the comments. Upload 
back to Google docs, if you wish, and maintain the comments. 
 
2. Open up a student’s essay in Microsoft Word®. Use the Quick Reference Guide 

with the alphanumeric entry codes and a short comment description, to guide your 
essay e-comment selection. The Quick Reference Guide organizes the essay e-
comments into writing response categories. Highlight the ones you use most often. 
 
3. Go to the Review tab in the Comments group. Left click the mouse where you 
want to place a comment. Click the New Comment image. In older Microsoft 
Word® versions, go to the Insert tab and then to Comments. 
 

 
 
4. The comment balloon will appear in the right margin or in a reviewing pane at the 
bottom of the screen or to the left of the screen. Adjust the comment location under 

Reviewing Pane in the Track Changes group. The keyboard shortcut to include a 
new comment is Ctrl + Alt + M. 
 
5. Type in the alphanumeric code for the selected essay e-comment and full comment 
appears in the comment balloon or where you decide is best. 
 

 
 
6. For repeated errors, simply highlight the text. The yellow marker is found under 
the “Home” tab. Of course, not every error need be marked. Consider using a balance 
of content and process essay e-comments, depending upon the instructional focus 
and the needs of each writer. 
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7. You can also personalize comments by adding to the comment balloons. You can 
even add audio comments to summarize overall strengths and weaknesses. To add an 
audio file (Sound Recorder) into Microsoft Word®, open Start; open All 
Programs; open Accessories; then open Sound Recorder. Click the button to 
start and stop recording. The Save menu will pop open and you can create a folder 
to save all of your audio files. Once saved, open up the folder and right click to copy 
the WMA file. Place your cursor where you want the file to appear in the student’s 
essay and paste Ctrl + V. The Sound Recorder file stays minimized as you open up 
other Microsoft Word® files, so you don’t have to go through the process each time. 
For better sound quality, I suggest using a microphone. 
 
8. Teach your students to revise and edit their documents in response to your essay 
e-comments. I suggest using Microsoft Word® Track Changes. Teach your 
students to go the Review tab and click on Track Changes, then revise and edit 
their document by inserting, deleting, moving, or formatting text. The resources in 
Change Tracking Options provide custom color and formatting options. The 
keyboard shortcut to turn on Track Changes is Ctrl + Shift + E. 
 

How to Add Your Own Permanent Autocorrect Entries in 
Microsoft Word® 
 
1. You can add your own e-comments onto the 438 essay e-comments bank. Here’s 
how: Type your e-comment. The text can include up to 255 characters of hyperlinks, 
different fonts, colors, italics, boldface, etc. Highlight the e-comment, but don’t copy 
it. 
 
2. Click the Microsoft Word® 2010 File. Then click Options. Next click Proofing. 
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3. With previous Microsoft Office® versions (before 2010), click File. Then click 

Word Options. Next click Proofing. 
 

 

 

4. Now click AutoCorrect Options. This page is similar in all recent Microsoft 
Word® versions. The highlighted text will appear within the With: text box.  
 
5. Enter an alpha-numerical code in the Replace: text box and click OK. 
 

 

6. Your own essay e-comment is now permanently saved on your computer. I suggest 
that you save all of your additional e-comments in a Microsoft Word® document so 
that you can easily add these on to other computers.  

 
 

Here is where the highlighted text appears. 
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Essay Writing Tips (formatted as Essay e-Comments) 
 
Students: 
 
A style manual is a writer’s reference guide. This guide is designed to help you write 
better essays and research papers. Following are 438 writing tips to help you do just 
that. Each writing tip has a concise definition, explanation, and a clear example. Writing 
tips are organized into these categories: Essay Organization and Development 
(Introduction, Body, and Conclusion), Coherence, Word Choice, Sentence Variety, 
Writing Style, Format and Citations, Parts of Speech, Grammatical Forms, Usage, 
Sentence Structure, Types of Sentences, Mechanics, and Conventional Spelling Rules. 
 
The alphanumeric listings are coded so that your teacher can easily insert these 
comments into Microsoft Word® documents and/or onto printed comment pages. Your 
teacher may ask you to use the comments to respond to writing completed by your 
peers.  
 
Your teacher may not choose to comment on every writing error or issue. However, if 
your teacher does include a comment, do your best to revise your writing accordingly 
and make a mental note, or better yet an actual note, to learn the writing terms and 
rules to apply on future writing assignments. 
 
Mark Pennington 
 
 
 
Essay Writing Rules and Style 
  
e73 Redundant Avoid repeating ideas, words or phrases, and cited sources. 
Redundancy suggests padding or over-reliance on single ideas of sources of information. 
  

e74 Needs Parallel Structure Repeat key words or  grammatical structures to create 
a memorable writing rhythm. These parallel structures can improve reader    
comprehension.   Example: We cannot dedicate… We  cannot consecrate… We cannot 
hallow this ground (Lincoln’s “Gettysburg Address”). 
  

e75 Delete Slang Essays are formal writing, so slang is not permitted. Example: The 
kids studied hard for their exams. Revision: The children studied hard for their exams. 
 
 e76 Delete Poetic Device Essays are formal writing, so poetic devices are not 
permitted. Example: The cold passed reluctantly from the earth… (Crane’s Red Badge 
of Courage) Revision: The weather warmed. 
  
e77 Delete Figure of Speech Essays are formal writing, so figures of speech are not 
permitted. Example: Jean let the cat out of the bag about the plot of the upcoming         
episode. Revision: Jean revealed the plot of the upcoming episode. 
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e78 Revise Rhetorical Question Avoid rhetorical questions in essays. A rhetorical 
question is a question needing no response because the answer is in the question itself. 
Example: Does anyone really think we should start over? 
  
e79 Revise Informal Writing Essays are formal writing, so informal, conversational 
writing style is not permitted. Example: FYI… Ron and Hermione have been going out 
for a year. Revision: Ron and Hermione have been dating for a year. 
 
e80 Revise: Too Many “to-be verbs” Consider limiting use of is, am, are, was, were, 
be, being, been to one per paragraph. To replace “to be verbs”: 1. Substitute a more   
active verb 2. Begin the sentence with another word from the sentence 3. Change one of 
the words in the sentence into a verb form. 
 
e81 Revise: Too Many Prepositional Phrase Strings Avoid using more than two 
prepositional phrases back-to-back. Example: The rabbit ran under the fence, through 
the garden, to the cabbage patch. Revision: The rabbit ran under the fence and into the 
garden. It stopped at the cabbage patch. 
 
e82 Revise Parenthetical Remarks Avoid using parenthetical remarks in essays. Try 
using commas for appositives or a subordinate clause to include the information. 
Example: He continued to try (the man in red had failed twice). Revision: He 
continued to try, although the man in red had failed twice. 
 
e83 Don’t start sentences with coordinating conjunctions. Avoid beginning 
sentences with the coordinating conjunctions (F.A.N.B.O.Y.S.-for, and, nor, but, or, yet, 
so) unless you finish the thought. Otherwise, fragments often result. 
 

e84 Don’t split infinitives. Infinitives consist of “to” plus the base form of the verb 
and serve as adjectives, adverbs, or nouns. Don’t add in a word(s) between the “to” and 
base form of the verb in formal essay writing. Example: To quickly leave made sense. 
Revision: To leave quickly made sense. 
  

e85 Don’t end sentences with prepositions. A preposition always appears at the 
beginning of a prepositional phrase and connects in time, space, relationship, or 
position to its object. A preposition can’t be used by itself in formal essay writing. 
Example: Don’t ever give up. Revision: Always persevere. 
  
 e86 Revise Double Negative Avoid using double negatives to indicate a positive in 
formal essay writing as this construction tends to confuse the reader. Example: Do not 
ever fail to use soap to wash dishes. Revision: Always use soap to wash dishes. 
  
e87 Using not as Denial Avoid using the word not to deny a positive assertion. 
Example: She was not frequently on time to class. Revision: She was frequently late to 
class. 
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e88 Revise Passive Voice Avoid using passive voice, in which the subject of the 
sentence receives the action of the predicate. Instead, revise to active voice, in which the     
subject of the sentence does the action. Example: The pen was given to the teacher by 
Jim. Revision: Jim gave the pen to the teacher. 
  
e89 Excessively Wordy Concise writing is better understood than wordy writing. 
Eliminate unnecessary words at the beginning of sentences. Examples: It is… There 
is… There are… This… I think… I believe… In my opinion. 
  
e90 Excessively Wordy Concise writing is better understood than wordy writing. 
Eliminate “who,” “which,” and “that” if possible. Example: oatmeal which was mushy 
Revision: mushy oatmeal Example: The children, who talked loudly, didn’t listen. 
Revision: Talking loudly, the children didn’t listen. Example: She was acting like a 
child. Revision: She acted childishly.  
  
e91 Excessively Wordy Concise writing is better understood than wordy writing. 
Replace wordy and weak verb forms with strong verbs. Example: She was acting like a 
child. Revision: She acted childishly.  
 
e92 Excessively Wordy Concise writing is better understood than wordy writing. 
Replace “_tion” and “_sion” noun constructions with strong verbs. Example: He 
turned in the application for the job. Revision: He applied for the job.  
 

e93 Excessively Wordy Concise writing is better understood than wordy writing. 
Replace prepositional phrases with modifiers when possible. Example: The principal 
of the school supervised the painting of the gym. Revision: The school principal 
supervised painting the gym. 
  
e94 Excessively Wordy Concise writing is better understood than wordy writing. 
Combine two sentences with a colon to indicate their relationship. Example: The 
teacher discussed two subjects. The subjects were reading and writing. Revision: The 
teacher discussed these subjects: reading and writing. 
  
e95 Excessively Wordy Concise writing is better understood than wordy writing. 
Combine two sentences into one to form a complex, compound, or                     
compound-complex sentence. Example: She was not happy. This was a result of her 
being lonely. Revision: Because she was lonely, she was not happy. 
  
e96 Omit Needless Words Delete expressions that do not add meaning to a sentence, 
especially those that include the word that. Examples: owing to the fact that, despite 
(in spite of) the fact that, call your attention to the fact that, the fact that. 
  
e97 Omit Needless Words Delete expressions that do not add meaning to a sentence, 
especially those that include the phrases: who is and which is. Examples: My wife, 
who is a gourmet cook, used cumin, which is my favorite spice. Revision: My wife, a 
gourmet cook, used cumin, my favorite spice. 
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e98 Needs 3rd Person Compose essays in the third person, not in first or second person 
voice. Focus on the subject, not the author-reader conversation. Don’t use first person    
pronouns: I, me, my, mine, myself, we, us, our, ours, ourselves or second person 
pronouns:  you, your, yours, yourself, yourselves 
  
e99 Overstated Idea The idea or evidence is exaggerated or overstated. 
Understatement and statements as to the limitations of an argument or conclusion are 
more convincing to your reader. 
  
e100 No Abbreviations Formal essays do not permit abbreviations. However, common 
acronyms are permissible. Examples: The U.A.R. supplied an astronaut for the new 
N.A.S.A. space launch. Revision: The United Arab Emirates supplied an astronaut for 
the new N.A.S.A. space launch. 
  
e101 No Contractions Formal essays do not permit contractions. Examples: They 
shouldn’t talk when they don’t understand the subject. Revision: They should not talk 
when they do not understand the subject. 
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